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Introduction 
This tutorial is designed to introduce the Land Information New Zealand’s SNAP 
least squares adjustment software. The datasets accompanying this tutorial 
are simulated and have been constructed to highlight ways in which SNAP can 
be used with different types of survey data. 

LINZ welcomes feedback/suggestions on the SNAP software and this tutorial. 

To provide feedback, please email customersupport@linz.govt.nz with the 
words “SNAP” and “geodetic” in the subject line. 

Target audience 

The tutorial is aimed at surveyors and others who have been previously introduced to SNAP 

and wish to learn how to use it to undertake more complex adjustments. It particularly 

focusses on functionality added to SNAP over the past few years. 

It assumes some prior knowledge of least squares terminology and analysis. It also assumes 

basic knowledge of SNAP, such as the general file structure and how to use it to complete a 

straight-forward least squares adjustment. 

SNAP version 

This tutorial was developed using SNAP Version 2.7.7, dated Oct 18 2017. Some of the 

functionality covered is not available in older versions of the software. Future versions of SNAP 

are expected to be backwards-compatible, so it is recommended that the most recent version 

available from the LINZ website is used. 

Download and install SNAP 

The latest version of SNAP can be downloaded and installed from the Land Information New 

Zealand website https://www.linz.govt.nz/data/geodetic-services/download-geodetic-

software/snap-concord-downloads 

Perl and connection to Geodetic Database 

Some of the SNAP utility programs used in this tutorial require a Perl interpreter. This can be 

downloaded and installed from: 

https://www.activestate.com/activeperl 

Importing stations from the LINZ Geodetic Database requires a connection to the Geodetic 

Database. 

Files required 

To run this tutorial, the following files contained in linz_snap_tutorial_initial_20171101.zip are 

required: 

affected_area.wkt 

demo_rotoiti_gnss.csv 

demo_rotoiti_lvl.csv 

demo_rotoiti_lvl.dtf 

demo_rotoiti_pb_ed_lv.dat 

mailto:customersupport@linz.govt.nz
https://www.linz.govt.nz/data/geodetic-services/download-geodetic-software/snap-concord-downloads
https://www.linz.govt.nz/data/geodetic-services/download-geodetic-software/snap-concord-downloads
https://www.activestate.com/activeperl
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min_RGMK_0.snx 

All other files are created as required in the tutorial. 

The final set of files used to run the adjustment by the end of the tutorial is contained in 

linz_snap_tutorial_final_20171101.zip. These may be useful if problems are experienced 

during the tutorial (eg if a step is accidentally missed). 

SNAP help 

This document should be used in conjunction with the in-software SNAP Help which can be 

accessed from Help > Help or by pressing F1 from within SNAP. 

The SNAP Help provides full documentation of the commands, software operations and data 

file formats used in this tutorial. 

Tutorial scenario 

This tutorial is based on the following scenario: 

- Survey five existing marks, which are not in the LINZ Geodetic Database, to LINZ Order 

4 standards. These marks are named ALICE, BRODY, CRAIG, DEVON and ETHEL and were 

initially installed and surveyed in 1995. 

- Connect this network to at least three reliable Order 3 or better geodetic marks. 

- The height uncertainty at the 95% confidence interval for DEVON and ETHEL must be 

0.005m relative to ALICE. 

- Using bearings, distances and height changes observed in 1995, assess which of the 

five marks (ALICE, BRODY, CRAIG, DEVON and ETHEL) is subject to local deformation. 

For our existing Order 3 or better control marks, we choose the following marks, these being 

the closest to our job:  BE48, BXUJ and RGMK 

Note that BE48 and BXUJ are passive control marks, while RGMK is a Continuously Operating 

Reference Station (CORS) operated by GeoNet, with publically available data. Further details of 

these marks are available in the Geodetic Database: 

http://apps.linz.govt.nz/gdb/index.aspx?code=BE48 

http://apps.linz.govt.nz/gdb/index.aspx?code=BXUJ 

http://apps.linz.govt.nz/gdb/index.aspx?code=RGMK 

  

http://apps.linz.govt.nz/gdb/index.aspx?code=BE48
http://apps.linz.govt.nz/gdb/index.aspx?code=BXUJ
http://apps.linz.govt.nz/gdb/index.aspx?code=RGMK
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 Setup a new SNAP job 1
1.1 Create a folder for the tutorial named snap_demo_rotoiti 

 

1.2 Copy the six files from linz_snap_tutorial_initial_20171101.zip into this folder 
 

 
 

1.3 Open SNAP: eg Start > Run SNAP 
 

 
 

1.4 File > New and complete the form as follows: 
 
Job title: SNAP Demo Rotoiti 

SNAP command file: Browse to your job folder and name the file demo_rotoiti 

Coordinate file option: Select Create a new empty file with the same name as the 
command file 
 

All other sections of the form use the defaults. 
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Click OK 
 

In the Edit/View data files form, click Add… and select the file demo_rotoiti_gnss.csv 
from the job folder (if you can not see it initially, change the viewable file types to All 
files (*.*)) 
 

 
 
Click OK 

 
There should now be two new text files in the job folder: 
demo_rotoiti.crd (SNAP coordinate/station file) 
demo_rotoiti.snp (SNAP command file) 
 

  



 

SNAP Tutorial   
Land Information New Zealand © Crown Copyright  |  1 November 2017 |  7 

 Edit the command file 2
2.1 Open the command file: Adjust > Edit command file 

 

2.2 Delete all the comments, ie lines starting with (!), EXCEPT for: 
 
! reference_frame ITRF2008 IERS_ETSR 2000.0 -4.8 -2.09 17.67 -1.40901 

0.16508 -0.26897 -0.11984 -0.79 0.6 1.34 0.10201 0.01347 -0.01514 -0.01973   

 
which will be used later in the tutorial 
 

2.3 Delete the following lines: 
 
max_iterations 5 

convergence_tolerance 0.0001 

max_adjustment 1000 

 

2.4 At this point, the command file should contain the following: 
 
title SNAP Demo Rotoiti 

 

coordinate_file demo_rotoiti.crd 

 

data_file demo_rotoiti_gnss.csv csv 

 

mode 3d adjustment 

 

fix  

 

deformation datum 

 

! reference_frame ITRF2008 IERS_ETSR 2000.0 -4.8 -2.09 17.67 -1.40901 

0.16508 -0.26897 -0.11984 -0.79 0.6 1.34 0.10201 0.01347 -0.01514 -0.01973 

   

2.5 Edit the data_file command to reference a SNAP csv format definition file (which will be 
created next) and enable the application of an error factor to the file: 
 
data_file demo_rotoiti_gnss.csv csv format=demo_rotoiti_gnss error_factor 

1.0 

 

2.6 Add a station to hold fixed for the minimally constrained adjustment, BE48: 
 
fix BE48 

 

2.7 Add a command to hold the three Order 3 and better stations fixed for the constrained 
adjustment. Tell SNAP to ignore this line for the moment (since the minimally 
constrained adjustment will be completed first) by turning it into a comment using an 

exclamation mark at the start of the line. The fixed stations could also be listed by their 
station codes, but this command uses the order classification: 
 
!fix order=2 order=3 

 

2.8 Add commands to output csv files, set observation and coordinate precisions and specify 

the statistical test for outliers: 
 
output_csv all 

output_precision GB 3 

coordinate_precision 3 

flag_significance 95 maximum 95 

 

2.9 At this point, the SNAP command file should look like this: 
 
title SNAP Demo Rotoiti 

 

coordinate_file demo_rotoiti.crd 

 

data_file demo_rotoiti_gnss.csv csv format=demo_rotoiti_gnss error_factor 
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1.0 

 

mode 3d adjustment 

 

fix BE48 

 

!fix order=2 order=3 

 

deformation datum 

 

! reference_frame ITRF2008 IERS_ETSR 2000.0 -4.8 -2.09 17.67 -1.40901 

0.16508 -0.26897 -0.11984 -0.79 0.6 1.34 0.10201 0.01347 -0.01514 -0.01973  

 

output_csv all 

output_precision GB 3 

coordinate_precision 3 

flag_significance 95 maximum 95 
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 Setup the GNSS baseline CSV 3

definition file 
3.1 Copy an existing CSV observation definition file to your job folder: 

 
File > Configuration > CSV format definitions 
 

In the form, choose the following options: 
 
Current files: Select obs (System) 
Copy file to: Job directory 
Rename copy to: demo_rotoiti_gnss 

 

 
 
Click Copy and edit file 
 

3.2 Edit the top line to describe the format: 

 
format_name SNAP CSV obs format for Rotoiti GNSS Baseline Demo 

 

3.3 Remove obstype from the line starting required_columns (the default observation type 
will be specified further in the file): 
 
required_columns fromstn tostn 

 

3.4 Set the default observation type to GNSS baseline by appending the line starting TYPE 

with DEFAULT "GB": 
 
TYPE @obstype DEFAULT "GB" 

 

3.5 Specify the a priori observation uncertainties in the east, north and up components by 
amending the line starting ERROR as follows: 
 
ERROR @error DEFAULT "4 4 8 mm 0.5 0.5 1 ppm" 

 

3.6 Set the line starting VECTOR_ERROR_TYPE to: 

 
VECTOR_ERROR_TYPE calculated 

 

3.7 Delete the following lines, which are not needed for our particular data: 
 
ID @id 
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SET_ID @obsset 

INSTRUMENT_HEIGHT @fromhgt 

TARGET_HEIGHT @tohgt 

PROJECTION c_Projection 

 

3.8 The dtf file should now contain the following text: 
 
format_name SNAP CSV obs format for Rotoiti GNSS Baseline Demo 

FORMAT CSV HEADER=Y 

required_columns fromstn tostn  

 

OBSERVATION 

TYPE @obstype DEFAULT "GB" 

REJECTED rejcode(@status) 

INSTRUMENT_STATION @fromstn 

TARGET_STATION @tostn 

DATETIME @date 

DATETIME_FORMAT YMDhms 

VALUE @value1 " " @value2 " " @value3 DEFAULT @value 

ERROR @error DEFAULT "4 4 8 mm 0.5 0.5 1 ppm" 

VECTOR_ERROR_TYPE calculated 

CLASSIFICATION_COLUMNS c_** 

END_OBSERVATION 

 

LOOKUP rejcode 

rej Y 

reject Y 

* Y 

default N 

END_LOOKUP 
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 Setup the coordinate file 4
4.1 Open the station coordinate file: Stations > Edit station file 

 

Note that it currently contains no station coordinates. 
 

4.2 Import the coordinates of the control stations from the LINZ Geodetic Database: 
 
Stations > Import Stations > LINZ GDB 
 

Accept all the defaults: 
 

 
 
Click OK 
 
This searches the data file(s) for existing geodetic codes from the LINZ Geodetic 
Database and imports coordinates. In this case, it adds the coordinates for BE48, BXUJ 

and RGMK. 
 

4.3 Calculate approximate coordinates for the remaining five stations: 
 
Stations > Calc missing stations… 

 

4.4 The coordinate file should now contain the following text: 
 
SNAP Demo Rotoiti 

NZGD2000 

options ellipsoidal_heights no_deflections no_geoid_heights c=Order c=MarkType 

 

!Code       Latitude          Longitude        Ell.Hgt Order MarkType Name 

RGMK   38 08 18.029742 S 176 28 01.606364 E   955.3660 2     FCTR  Makatiti 

BE48   38 03 08.659555 S 176 27 06.853280 E   309.3430 3     PIN   GISBORNE POINT 

BXUJ   38 02 27.544985 S 176 32 49.275629 E   336.6280 3     PIN   MANAWAHE ROAD 

ETHEL  38 07 00.815605 S 176 28 15.525642 E   341.6487 -     -     ETHEL 

CRAIG  38 06 34.545670 S 176 29 12.665351 E   307.7665 -     -     CRAIG 

BRODY  38 06 02.628713 S 176 28 16.318197 E   327.9953 -     -     BRODY 

ALICE  38 06 22.746023 S 176 27 23.525633 E   313.3123 -     -     ALICE 

DEVON  38 06 54.776116 S 176 28 48.903854 E   320.2586 -     -     DEVON 
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 Minimally constrained GNSS 5

baseline adjustment 
5.1 In the command file, ensure that only BE48 is fixed, then run the adjustment: 

 
Adjust > Run adjustment 
 

5.2 View the SNAP report: 
 
Adjust > View report 
 
Note the following: 

 
1) The standard error of unit weight is 1.31. This is a little higher than we would 

expect, which may indicate the presence of gross errors or that we have been 
overly optimistic when estimating the observation uncertainties: 
 

Standard error of unit weight:        1.31043 

 

The probability of an SSR this high is 2.152% (from Chi squared (21)) 

 

You may have under-estimated the errors of the data, 

or there may be gross errors in the data 

or the fixed stations may be incorrectly positioned 

 
2) There are two triple-flagged (???) observations. This indicates that statistically, 

these are outliers and may contain gross errors (although note that the actual 
residual is 15mm for the first outlier and 10mm for the second, neither of which is 

particularly large).  
 
From  To    Type    Value      +/-       Calc      +/-     Res    +/-    S.R.       

                    X,Y,Z               X,Y,Z             E,N,U  

                    

BXUJ  CRAIG GB       5031.618  0.010     5031.602  0.007   0.000  0.004   0.03      

                     4983.211  0.006     4983.212  0.004  -0.015  0.004   3.39  ??? 

                    -5977.595  0.009    -5977.589  0.006  -0.009  0.009   1.01      

                     9267.212            9267.200          0.017          2.04  ? 

 

ETHEL ALICE GB       -622.729  0.007     -622.737  0.005   0.004  0.003   1.37      

                     1307.728  0.004     1307.732  0.003  -0.010  0.003   4.01  ??? 

                      941.078  0.006      941.085  0.005  -0.003  0.005   0.50      

                     1727.302            1727.312          0.011          2.46  ??? 

 
3) The RMS value for the standardised residuals for the north component is 

significantly larger than those for the east and up components. This could indicate 

that the observation uncertainties for the north component are too tight, relative 
to the other components. It could also indicate the presence of gross errors in the 
north component.  

 
Classification                               Used        Unused       Total 

                                            RMS  Count   RMS  Count   RMS  Count 

 

GPS baseline                                1.38   42     -      -    1.38   42 

        East component                      0.65   14     -      -    0.65   14 

        North component                     2.23   14     -      -    2.23   14 

        Up component                        0.57   14     -      -    0.57   14 

 

5.3 View in SNAPPLOT: 
 
Adjust > Plot adjustment 

 

5.4 Turn on station codes (Code checkbox in the right-hand panel) 
 

5.5 Set error type to apriori 95% confidence interval: 

 
Errors > Error options… 
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5.6 Colour the observations by apriori standardised residual: 

 
Observations > Colour coding… > Residual… 
 

 
 

5.7 SNAPPLOT should now look like this: 
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5.8 Note that there are two ‘blue’ observations, indicating standardised residuals between 
2.00 and 2.50. These are the same two observations identified in the report as having 
components that are potential outliers. Click on one of the blues lines and then the GPS 
baseline observation to see the full details of the observation. 
 

In this case, the two observations are not really outliers, due to the fact that their 
residuals are reasonable for the type of observation. The flagging of these as outliers 
likely reflects that the observation uncertainties are not quite right, requiring some 
reweigting. 
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5.9 Click the Observations tab 
 
Right-click in the header of the tab and add the SESSION field. SESSION was a category 

used in the GNSS CSV file to indicate which session a particular baseline belonged to. 

 

 
5.10 Save this configuration so that it will be used by default whenever SNAPPLOT is opened 

for this job: 
 
File > Save configuration… 
 
Save in the job folder as snapplot.spc 
 

5.11 Reweight the data file. Reweighting often requires considerable professional judgement. 
While the adjustment statistics (eg SEUW) provide useful guideance on how the data 
might be reweighted, the results (eg observation uncertainties and error ellipses) of any 
reweighting should always be considered to ensure they are reasonable and realistic. 

There are several potential approaches to reweighting, three of which are detailed below. 
 

Approach 1 – Reweighting by SEUW 
 
Probably the most common approach is to set the error factor to equal the SEUW, which 
will scale all the observation uncertainties by that amount. 
 
Approach 2 – Reweighting by RMS component 

 
But for this job there are two pieces of information which suggest that an alternative 
approach could be worthwhile: 
 

1) The RMS values indicate that the uncertainty of the north component is more than 
the east component (these had been set in the dtf file to be equal) 

2) We usually expect GNSS data to be a little less accurate in the north component 

compared to the east component due to the geometry of the satellite constellation 
(very few satellites to the south of New Zealand) 

 
Scaling each of the components (east, north and up) by its RMS value would lead to 
observation uncertainties of 3 9 5 mm 0.3 1.1 0.6 ppm.  

 
One problem with this approach is that the resulting observation uncertainties are 
unrealistic. For example, 3mm and 0.3ppm is quite tight for the east component. And 

having the north uncertainty almost twice the size of the up uncertainty is inconsistent 
with the fact that GNSS is typically 2-3 times less accurate in the up direction compared 
with the horizontal. Note that there are only 14 observations, which is a small number 
from which to calculate RMS values and could lead to them being unreliable. 
 
Approach 3: Reconsider initial estimates of uncertainty 
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In this approach, reconsider the initial estimates of observation uncertainty, perhaps after 
consulting equipment manuals or considering previous experience with the equipment. 

 

In this case, previous experience with the GNSS equipment suggests that the north 
component has a greater uncertainty than the east component by a factor of up to 1.5. 
This would result in observation uncertainties in the dtf file of 4 6 8 mm 0.5 0.75 1 ppm.  

 
Decision 
 
Note that all three approaches produce satisfactory results, in that the SEUW is close to 

1.0, reasonable observations are no longer triple-flagged as outliers and the observation 
and coordinate uncertainties are reasonable (except perhaps for Approach 2, where the 
north uncertainty is particularly large). 
 
In this case, Approach 3 is chosen, and uncertainties in the dtf file updated accordingly. 
After doing this and rerunning the adjustment, the SEUW is 0.95. This is close enough to 
one, so applying an error factor to the data file is not required. 
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 Constrained GNSS baseline 6

adjustment 
6.1 Open the command file, comment fix BE48 and uncomment fix order=2 order=3 to 

ensure that the three existing control stations are held fixed. 
 

6.2 Run SNAP and open SNAPPLOT. 

 
Note that the SEUW is 2.16 and there are a number of high standardised residuals. It 
appears that one or more of the fixed station coordinates is inconsistent with the 
observations. It cannot be assumed that the problem is with the fixed coordinates. It is 
possible that there is a systematic error in the observations, which is not apparent in a 
minimally constrained adjustment. 
 

6.3 Determine if the inconsistency is limited to a particular control mark by freeing up each 
of the three control marks in turn and observing the impact on the network. For 
example, first free up BE48, making sure the ‘free’ command is below the ‘fix’ 
command, as SNAP reads the commands in sequence: 

 
fix order=2 order=3 

free BE48  

 

The table below summarises the results of doing this: 
 

Free control station SEUW Number of outliers 

BE48 1.81 2 

BXUJ 1.83 3 

RGMK 1.04 0 

 
Based on this, it appears that only RGMK has a conflict, because when BE48 and BXUJ 

only are fixed, the SEUW is close to one and there are no outliers. 
 

6.4 Open SNAPPLOT and click on RGMK to view details of the coordinate change: 
 

 
 
The vertical movement is 55mm downwards. That is, the surveyed position of RGMK 
(according to the GNSS baseline data) is 55mm below the position provided in the 
Geodetic Database. There are a number of possibilities for this conflict: 
 

1) The 55mm spacer on RGMK was not correctly treated in the processing 
2) The antenna phase centre model was not correctly applied in the GNSS 

processing software for this CORS 
3) The coordinate in the Geodetic Database is incorrect 
4) There has been localised subsidence at RGMK (which does not affect BE48 and 

BXUJ) 
 

After some investigation it is determined that RGMK is indeed subsiding, such that it has 
dropped about 5cm between the time its coordinate was calculated for the Geodetic 
Database and the time of this survey. 
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 GNSS point (SINEX) data 7
Since RGMK is a CORS, data from it can be processed using PositioNZ-PP and included in the adjustment. 

This enables the network to be connected to additional reliable control stations without making additional 
field observations. 

 
One of the products of the PositioNZ-PP processing is a minimally constrained SINEX file in terms of 
ITRF2008 called min_RGMK_0.snx 
 

7.1 Update the command file to reference the SINEX file: 
 
data_file min_RGMK_0.snx sinex ref_frame=ITRF2008 error_factor 1.0 

 

7.2 Uncomment the command to apply the ITRF2008 reference frame transformation 
 

7.3 Comment out the reference to the demo_rotoiti_gnss.csv data file, so that only using 
the SINEX file is used 
 

7.4 The SINEX file includes the PositioNZ stations TAUP, TRNG and WHKT. Add these to the 
coordinate file by updating from the Geodetic Database: 

 
Stations > Import stations > LINZ GDB 
 

7.5 Run the adjustment. Note that this minimally constrained adjustment has no 
redundancy, so we cannot make a statistical assessment of the SINEX data. 
 
Note also that no stations were fixed to run the adjustment. This is because the GNSS 
point data is an absolute observation in terms of ITRF2008 (which SNAP uses to 
calculate NZGD2000 coordinates using a reference frame transformation and the 

NZGD2000 deformation model). 
 

7.6 Open in SNAPPLOT and note the size of the coordinate changes at the PositioNZ 
stations. They are mostly less than 0.01m, which indicates that the SINEX data is 
consistent with the existing NZGD2000 coordinates.  
 

7.7 Fix the PositioNZ stations by adding order=0 to the fixed station command: 

 
fix order=0 order=2 order=3 

 

7.8 Run the adjustment. 
 
From the SNAP report, the SEUW is 285 and the standardised residuals range from 46 to 
403. 

 

7.9 Open in SNAPPLOT. 
 
Click on RGMK and note that the error ellipse is 0.3mm and the height error 1.1mm. For 
the 24 hours of GNSS data at RGMK, values closer to 5mm horizontal and 10mm vertical 
at a 95% confidence level would be expected. These values are based on experience, 

but are also consistent with the residuals for this data file. 
 
Click on each of the PositioNZ stations and note that the residuals are almost all less 
than 0.01m. 
 

This indicates that the observations are fine, despite the very high standardised 

residuals. The problem is that the observation uncertainties (the covariance matrix in 
the SINEX file) are far smaller than they should be. This is a common challenge with 
GNSS point data, as the GNSS processing software is not able to account for all the 
sources of error that impact the observations. 
 

7.10 Reweight the data file by scaling by the SEUW of 285: 

 
data_file min_RGMK_0.snx sinex ref_frame=ITRF2008 error_factor 285.0 

 

7.11 Run the adjustment and open in SNAPPLOT. 
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The SEUW is now 1.0 and there are no outliers. 
 

Click on RGMK and note that the error ellipse is now 76mm and the height error 

323mm. So the coordinate uncertainties have gone from being unrealistically small to 
unrealistically large. 
 
Above, it was suggested that reasonable uncertainty values for RGMK would be 5mm 
horizontal and 10mm vertical. This suggests the original uncertainties of 0.3mm and 
1.1mm need to be scaled by about 15 for the horizontal component and 9 for the 

vertical component. 
 
Therefore scale the data file by the larger of these values: 
 
data_file min_RGMK_0.snx sinex ref_frame=ITRF2008 error_factor 15.0 

 

7.12 Run the adjustment and open in SNAPPLOT. 

 
The SEUW is now 19 and there are still large standardised residuals (although the 
residuals themselves are still similar to what they were previously). 
 

Click on RGMK and note that the error ellipse is now 4mm and the height error 17mm. 
These are much more realistic values. 

 
Even though the weighting of the SINEX file is now reasonable, the high SEUW and 
standardised residuals are problematic as they have the potential to hide real issues 
with other datasets that we add to this adjustment. 
 
The reason for the high SEUW is that the fixed PositioNZ coordinates are in conflict with 
the GNSS point data, including the covariances within the SINEX file which act as 

constraints on how the observations can be adjusted to fit the fixed coordinates. 
 
One approach to resolve this conflict is to recognise that assuming the fixed stations are 
error-free is not realistic. In SNAP, uncertainties can be assigned to fixed stations to 
account for this, which is referred to as floating the station. In this case, the uncertainty 
in the fixed stations is estimated to be 5mm horizontally and 10mm vertically. 
 

7.13 Add the following commands to the command file, below the last ‘fix’ command: 

 
horizontal_float_error 0.005 

vertical_float_error 0.010 

 

float order=0 order=3 

 
Note that the Order 2 station (ie RGMK) is not floated because it is known that this 
station has a discrepancy in the height and therefore should not be constrained to the 
height in the coordinate file. 

 

7.14 Comment out all the fix commands. 
 

7.15 Run the adjustment and view in SNAPPLOT. Note that the PositioNZ stations now have 
coordinate changes. The SEUW is now 1.1 and there are no observations flagged as 

outliers. 
 

7.16 Uncomment the reference to the GNSS baseline file and rerun the adjustment. 
 

Note that the issue with the height conflict at RGMK is now resolved. 
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 Levelling data 8
8.1 Comment out the two GNSS data files and add references to the levelling data file: 

 
!data_file demo_rotoiti_gnss.csv csv format=demo_rotoiti_gnss error_factor 

1.0 

!data_file min_RGMK_0.snx sinex ref_frame=ITRF2008 error_factor 15.0 

data_file demo_rotoiti_lvl.csv csv format=demo_rotoiti_lvl error_factor 

1.0 

8.2 Change the vertical coordinate system to NZVD2016. 

 
Stations > Change coordinate system… 
 
Select the following: 
 
Orthometric vertical datum: New Zealand Vertical Datum 2016 

Height coordinate type: Orthometric 
 

 
 

8.3 Add NZGeoid2016 geoid heights: 
 
Stations > Add geoid heights… 

 
Select the following: 
 
Geoid calculation option: Calculate geoid from reference surface 
Vertical datum: New Zealand Vertical Datum 2016. 
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8.4 Setup a minimally constrained levelling adjustment. 
 
In the command file, fix ALICE: 
 
fix ALICE 

 

8.5 Change the mode from 3d to 1d: 
 
mode 1d adjustment 

 

8.6 Run the adjustment and view the results in SNAPPLOT. Note the SEUW is 1.2 and there 
are no outliers. 

 

8.7 Reweight the levelling data using an error factor of 1.2: 
 
data_file demo_rotoiti_lvl.csv csv format=demo_rotoiti_lvl error_factor 

1.2 

 

8.8 Uncomment the GNSS data files 
 

8.9 Change mode from 1d to 3d 
 

8.10 Comment out the fix command for ALICE 
 

8.11 Run the adjustment and view results in SNAPPLOT. Note the SEUW is 0.96. 
 
Select the vector between ALICE and ETHEL and note that because levelling data is now 
included, the relative vertical uncertainty is much less than the horizontal uncertainty: 
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 Survey plan data (plus levelling) 9
9.1 Add a reference to the survey plan and levelling data file to the command file: 

 
data_file demo_rotoiti_pb_ed_lv.dat error_factor 1.0 

 

9.2 Comment out all the other data files 
 

9.3 Hold ALICE fixed 
 

9.4 Hold BRODY fixed in the vertical component (because there is no levelling data to 
BRODY) 
 

9.5 Run the adjustment and view in SNAPPLOT 
 

9.6 Apply an error factor of 1.1 (since the SEUW is 1.1) 
 

9.7 Uncomment the other data files and unfix ALICE and BRODY 
 

9.8 Run the adjustment and view in SNAPPLOT. 

 
The SEUW is 4.0 and there are several high standardised residuals, all relating to ALICE, 
CRAIG, DEVON and ETHEL. 
 
The terrestrial observations between ALICE and BRODY, and BRODY and CRAIG, have 
low standardised residuals. This indicates that ALICE, BRODY and CRAIG are in terms 

with each other. 
 
This suggests a problem with DEVON and ETHEL. Specifically, the 1995 observations 
from the survey plan and levelling do not agree with the 2017 observations in the other 
data files. 
 

After further investigation, DEVON and ETHEL are found to be located in an area of 
known localised deformation, which is defined by the well-known text file 
affected_area.wkt 
 

9.9 Separate the 2017 observations from the 1995 observations within the affected area by 

recoding stations within the affected area: 

 
recode suffix _A before 2017-01-01 for inside NZTM affected_area.wkt 

 

9.10 Run the adjustment and view in SNAPPLOT. 
 
The SEUW is now 0.96 and there are no outliers. Zoom in on DEVON and note that SNAP 
has split out the pre-2017 observations and connected them to the recoded mark 

DEVON_A. 
 
Double-click on DEVON and single-click on DEVON_A. SNAPPLOT calculates these two 
positions are separated by 0.061m horizontally and 0.199m vertically. 
 
ETHEL and ETHEL_A are similarly separated. 

 
The observations therefore confirm that DEVON and ETHEL have been subject to 
localised deformation since the original survey in 1995. 

 

9.11 Since the bearings are in terms of Bay of Plenty Circuit 1949, there could be an 
orientation error between NZGD1949 and NZGD2000. 

 
Note that SNAP’s “bearing orientation error” has the opposite sign convention to the 
“bearing swing” or “bearing correction” familiar in New Zealand cadastral surveying. 
 
Add the following to the command file: 
 
bearing_orientation_error calculate PLENTM1949 
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9.12 Run the adjustment and open the SNAP report. 
 
Find the “OTHER PARAMETERS” section and note the bearing error: 

 
Parameter                          value         +/- 

 

Bearing error PLENTM1949            -1.45381      1.18428  

 
The bearing error is -1.5 seconds with a 95% uncertainty of 2.3 seconds (multiplying the 
standard error of 1.18 by 1.96). 
 
Since the bearing orientation error is not significantly different from zero, it does not 
need to be calculated, so comment out this command and rerun the adjustment. 
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 Specification testing 10
10.1 For specification testing, comment out the station recoding and instead reject all 

observations to stations within the affected area made before 2017 using this command: 

 
reject_observations before 2017-01-01 using_stations inside NZTM 

affected_area.wkt 

 
Note that we would achieve the same outcome by rejecting, using an asterisk (*), all 
the observations between ALICE, DEVON, ETHEL and CRAIG in 
demo_rotoiti_pb_ed_lv.dat 
 

10.2 Set up the Order 4 specification and the 5mm vertical specification by adding the 
following to the command file: 
 
specification order_4 confidence 95% horizontal 10mm 10ppm 50mm_abs 

vertical 10mm 50ppm 135mm_abs 

 

specification rotoiti_vert confidence 95% vertical 5mm 

 

10.3 Specify which specification and which stations to test against each specification by 
adding the following: 
 
test_specification order_4 ALICE BRODY CRAIG DEVON ETHEL 

 

test_specification rotoiti_vert ALICE DEVON ETHEL 

 

10.4 Specify that only failed results are to be listed: 

 
spec_test_options list_fail 

 

10.5 Run the adjustment and open the SNAP report. 
 
Find the ACCURACY SPECIFICATION TESTS section and note the results. If the ratio of 
error to tolerances is less than 1, then the test passes. If the ratio is greater than 1, 
then the test fails. 

 
The absolute accuracy tests pass, as do the relative accuracy tests, for both accuracy 

specifications. 
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Appendix A: Final command file 
title SNAP Demo Rotoiti 

 

coordinate_file demo_rotoiti.crd 

 

data_file demo_rotoiti_gnss.csv csv format=demo_rotoiti_gnss error_factor 1.0 

data_file min_RGMK_0.snx sinex ref_frame=ITRF2008 error_factor 15.0 

data_file demo_rotoiti_lvl.csv csv format=demo_rotoiti_lvl error_factor 1.2 

data_file demo_rotoiti_pb_ed_lv.dat error_factor 1.1 

 

mode 3d adjustment 

 

!fix ALICE 

!fix vertical BRODY 

!fix BE48 

 

!fix order=0 order=2 order=3 

 

horizontal_float_error 0.005 

vertical_float_error 0.010 

 

float order=0 order=3 

 

free RGMK 

 

!recode suffix _A before 2017-01-01 for inside NZTM affected_area.wkt 

reject_observations before 2017-01-01 using_stations inside NZTM affected_area.wkt 

 

!bearing_orientation_error calculate PLENTM1949 

 

deformation datum 

 

reference_frame ITRF2008 IERS_ETSR 2000.0 -4.8 -2.09 17.67 -1.40901 0.16508 -0.26897 -

0.11984 -0.79 0.6 1.34 0.10201 0.01347 -0.01514 -0.01973  

 

output_csv all 

output_precision GB 3 

coordinate_precision 3 

flag_significance 95 maximum 95 

 

specification order_4 confidence 95% horizontal 10mm 10ppm 50mm_abs vertical 10mm 50ppm 

135mm_abs 

specification rotoiti_vert confidence 95% vertical 5mm 

test_specification order_4 ALICE BRODY CRAIG DEVON ETHEL 

test_specification rotoiti_vert ALICE DEVON ETHEL 

spec_test_options list_fail  


